Economics Analytics: ECON 2050

Module 12: Matrices and Array Formulas – Applications in economics
Learning Goal for Module 12
Important models in economics feature matrices. Array formulas are a common method in
Excel for calculating matrix operations, some of which are so common they are now functions
– the =SUMPRODUCT being a common example. Microsoft 365 has added improved
functionality in the form of dynamic arrays that reduce the work in setting up and using array
formulas.
This Module examines models in economics that use matrices, such as the input-output
model, which expresses linear regression in matrix format. In passing, this Module presents
additional Excel procedures that will speed up your work.
By the end of this Module, you will be able to
• Perform basic matrix operations using Excel
• Name ranges for easier computation
• Express linear models such as input-output analysis and regression in matrix format
• Use common array functions
• Appreciate the power of dynamic arrays in simplifying Excel calculations

1. Introduction
A matrix is a rectangular array/grid/table/spreadsheet. In the broadest interpretation, a matrix
can contain letters, words, symbols, etc., but for applications in economics, statistics, and
science, matrices usually contain numbers. The dimension of a matrix, usually written r x c,
describes its shape, which is important in basic algebraic operations. The corresponding
designation of a matrix in Excel is an array. Therefore, array formulas are operations on matrices.
1.1. Basic operations using matrices
The simplest possible matrices are unidimensional. The basic rules of algebra also work for
matrices.
1+3=4

…1

5x = 10 → x = (1/5) ● 10 = 2

…2

In the second equation, we often just think of moving the 5 across the equation to divide into 10,
but in fact the process involves creating an inverse operator (1/5) and multiplying it by 10. This
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may seem trivial, but the reason for thinking about solving an equation this way will quickly
become apparent.
Here are examples of higher dimensional matrices

a1n 
 .9   .2 1.1 −.7   a11
 
 

(2 −6 8 ) , −3  , 2 9 −13  , 

 45   5 0
 a

1
a
mn 
 
  m1
where the first and second are row and column matrices, respectively; the third is a rectangular
(square) 3 x 3 matrix, and the last a generic m x n matrix where letters signify constants or
unknowns as in any algebraic setting. The order of a matrix is its size, expressed as m x n. Row or
column matrices often have the designation of vectors. Each number in a matrix is an element.
See Example 12A.xlsx

1.2. Naming matrices
Matrix addition, subtraction, and scalar multiplication are straightforward, but before presenting
details, here is how to name a range of cells.
1. Highlight the range.
2. Now on the Ribbon bar, click FORMULA → Define
Name, and complete the process in the dropdown menu; notice how the range appears in the
menu. You can choose whether the name applies
to the Worksheet or the Workbook. (In general,
choose the former, until you start working with
complex models.)
3. You can name a vector in a row or column, or in
an array.
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1.3. Matrix addition, subtraction, and multiplication - review
Matrices can be added, subtracted, multiplied, and divided, with the important condition that
such operations apply only to conformal matrices. As shorthand, capital letters usually identify
matrices.
 2.00 
 1.75 
 200 150 50 




Q=
 P =  3.00  C =  2.25 
 300 250 300 
 4.00 
 3.75 




2 4
 −1 6 
A=
 , B=
 , C = ( 3 −1 3)
6 8 
 4 2
It is possible to add and subtract A and B, but not A and C or B and C. One can also multiply A and
B, but one cannot execute A*C nor B*C (where A*C refers to A multiplied by C).

 2 4   −1 6   2 − (−1) 4 − 6   3 −2 
A−B =
 -
 =
=

6 8   4 2  6 − 4 8 −2 2 6 

Matrix multiplication follows specific rules, requiring the matrices to have conformal dimensions.
Here are three matrices and their dimensions:
2 4 8 
1 
 1 7 14 


 


A =  1 2 4  ,B =  2  ,C = ( 3 2 1 ) ,D =  −1 −2 −3 
 3 6 12 
3
3 2 1


 



3x3

3x1

1x3

(3 x 3)

The multiplication rule is that the “inner” dimensions must be the same. This means that only
certain combinations can be multiplied. So, the following operations are defined.

 22 22 24 
 32 


 
AD =  11 11 12  ,B = (10 ) , AB =  16 
 33 33 36 
 51 


 
The mental math approach visualizes the following approach with the two 2x2 matrices A and B,
multiplied to produce C:
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 a11

 a21

a12  b11

a22  b21

b12   c11
=
b22   c21

c12 
 …3
c22 

c11 = a11* b11 + a12* b21
c12 = a11* b12 + a12* b22
… 4a-4d
c21 = a21* b11 + a22* b21
c22 = a21* b12 + a22* b22
Note that multiplying a 3x3 matrix times a 3x3 matrix produces a 3x3 matrix and multiplying a
3x3 matrix by a 3x1 matrix produces a 3x1 matrix. The operations BA and BD are not defined, but
the operations CA and CD are, because the inner dimensions are the same.

BA = (3x3)(1x3), BD = (3x3)(1x3)
CA = (1x3)(3x3), CD = (1x3)(3x3)
To manage the calculations in equations 4a – 4d, matrix multiplication uses an array formulation,
which can be a bit tricky. Consider the two matrices from
above, A and D. Applying equations 4a – 4d, now there are nine
Video: Matrix Naming and
Matrix Multiplication
calculations because of the extra dimension.

2 4 8 
 1 7 14 
 22 22 24 






A =  1 2 4  , D =  −1 −2 −3  , AD =  11 11 12 
 3 6 12 
3 2 1
 33 33 36 






A useful operation is scalar multiplication, where a scalar constant λ pre-multiplies the entire array.

2 4 8 
 A =  1 2 4  =
 3 6 12 



 2 4 8 


 1 2 4 
 3 6 12 



Example: A store with four branches sells three types of tires, with the following table (matrix)
showing the value of the inventory.
Tire Type→
Branch↓
St. Vital
St. James
East Kildonan
Transcona
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Off Road

Winter

Summer

$250,000 $45,000 $12,000
$120,000 $34,000 $100,000
$50,000 $103,000 $98,000
$102,000 $96,000 $32,000
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If the store introduces a 15% price reduction to tire type 1, a 7% reduction for tire type 2, and a
2% reduction for tire type 3, by how much does the total inventory lose value? (Answer:
$102,600. HINT – use the =SUMPRODUCT, which is an array formula embedded in a regular
formula.)
Example: Create a dashboard so that the discounts can vary to show the implications of policy.].
See Example 12B.xlsx
1.4. Matrix multiplication
Matrix multiplication follows the Distributive Law. Imagine a store sells three commodities in two
branches, with the selling prices and costs as noted. The goal is to calculate profits and then change
prices to recalculate profits.
Quantities Sold (Q)

Branch 1
Branch 2

Selling prices
($/unit) (P)

G1
G2
G3
200
150
50
300
250
300

G1
G2
G3

Costs ($/unit)
(C)

2.00
3.00
4.00

G1
G2
G3

1.75
2.25
3.75

Develop this in matrix format:

 2.00 
 1.75 
 200 150 50 




Q=
 P =  3.00  C =  2.25 
 300 250 300 
 4.00 
 3.75 




From microeconomic theory, Total Revenue (TR) equals price x quantity, and Total Costs (TC) equals cost
x quantity, or

TR = PxQ and TC = CxQ
However, according to the matrix multiplication rules, we need to write TR as QP and TC as QC.
Example: Using the above information, calculate the profit.

 2.00 
 1.75 
 200 150 50  
 200 150 50  


TR = QP = 
  3.00  ;TC = QC = 
  2.25  …5
300
250
300
300
250
300

  4.00 

  2.75 




Profit = TR - TC
Profit = $512.50

©Gregory Mason, July 2022

See Example 12C.xlsx

Economics Analytics: ECON 2050

Module 12: Matrices and Array Formulas – Applications in economics
This is not interesting but consider how the problem could become more complex.
Example 12D: Assume the price elasticity of Good 1 is -.7, the price elasticity of Good 2 is -1.5, and
the price elasticity of Good 3 is -.9. Recall that price elasticity predicts the change in quantity
demanded in response to a change in price. We start from the existing data, assuming the prices
and quantities above reflect an equilibrium.
ε = Percent Change in Quantity/Percent Change in Price
In each case, we use the given elasticity to calculate the quantity response to a change in price.
This creates a change in total revenue that changes profit. Create a dashboard to model the
effects of price changes on profit.
See Example 12D.xlsx

2. Solving equations – The identity matrix
Imagine the average salaries in Canada for 2000, 2005, 2010, and 2015 are $20,000, $20,300, $20,600,
and $20,900. Based on this, what is the expected salary in 2020? This is a simple l exercise, but it
supports the demonstration of how to solve a system of linear equations. This leads to more substantive
applications of matrix multiplication, such as linear regression and input-output analysis.
Here the dependent variable is salary, and the independent variable is time. The solution requires
solving a set of linear equations, expressed as the general equation, Y=a0+a1X, where Y is salary and X is
time. We could measure time directly as 2000, 2005, …, but we also let X be 0, 1, 2…, where every
increment represents five years.

The equation system appears as follows.

a0 + a1
a0 + a1
a0 + a1
a0 + a1

0 = 20000
1 = 20300
2 = 20600
3 = 20900

Intuitively, the solution is a straight line (every five years is associated with a $3,000 increment in
income). We use any two of these equations to find a0 = 3 and a1=5.
The identity matrix becomes the key to solving the general system of linear equations. Think of the
simple problem at the start of this chapter, 5x=10. To solve this, we commonly just divide both sides by
5, but as noted, this is the same as multiplying both sides by 1/5 or the inverse of 5. Write this as

1 / 5 X = 1 / 5 10
X =2
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The identity matrix for square matrices of different sizes appears as

a
( a1 ) = (a1 )(a1 ) = (1),  11
 a21
−1

 a11


a
 m1

a1n  a11


amn 
 am1

−1

a12  a11 a12 
1 0

 =
;
a22  a21 a22 
0 1
 1 0 ... 0 
−1
a1n 


0 1 ... 0 


 = : : : 0
amn 


0 0 0 1

 1 / a11 1 / a21 
 , but each element aij divided by a special value,
 1 / a 12 1 / a22 

The inverse of a square matrix is not 

known as the determinant of A. Fortunately, Excel supplies a special array formula for calculating
inverses.

The general expression of a system of linear equations appears as

AX = B ,
where A is a matrix that can have any dimension. In the simple example, A is a 1x1 matrix, where A = 5
and A inverse (1/5) appears as A-1, since 5-1 = 1/5. What we need is a way to create A-1 for higher
dimensional matrices for a system of equations.

3x − 2y + z = 7  3 −2 1  x   7 
 3 −2 1 





2x + y + 3z = 5 =  2 1 3  y  =  5  = AX = B; A =  2 1 3  … 6
 1 −1 2 
  
x − y + 2z = 8  1 −1 2 

 z   8 

The inverse matrix A-1 is that matrix, when multiplied by A produces the identity matrix. Back to the
simple example, the inverse matrix to A=5 (a 1x1 matrix) is A-1 = 1/5, since AA-1=1. So, for the above
system, we need to find A-1 for the matrix.
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 3 −2 1 


A = 2 1 3
 1 −1 2 



The Excel array formula MINVERSE
does that. It has a similar set-up as the
MMULT formula, and by the { } you see
this is an array formula (use CTRLSHIFT-Enter and not the checkmark).

A

Let us make sure this is the inverse by
multiplying A times A-1.
A-1

1 0 0


In general AA = I will be the identity matrix for square matrices. For the 3x3 matrix I = 0 1 0 .


0 0 1


-1

See Example 12E.xlsx

See Video: Matrix Inverse

What????

This is an example of round-off error.
Use Format Cells to format these cells
as numbers with no decimal and the
3x3 identity matrix will emerge.
Practice with any size matrix.
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If you see cells filled with #NUM!, that usually means an inverse does not exist. This occurs when the
determinant of A does not exist, which usually reflects a situation when rows or columns are multiples
of each other. If you can multiply a row (or column) by a number and add or subtract it from another
row (or column) to get 0, an inverse to that matrix will not exist. This is the rule that says, in a linear
system of k variables, you need k equations to find a unique solution (see equation 6 above).
The solution to 6 requires multiplying both sides of the equation by A-1.

 .36 .21 −.5  3 −2 1  x   .36 .21 −.5  7 


  
 
A−1 AX = A−1B =  −.07 .36 −.5  2 1 3  y  =  −.07 .36 −.5  5 
 −.21 .07 .5  1 −1 2  x   −.21 .07 .5  8 


  
 
(3x3)
(3x3) (3X1)
(3x3)
(3x1)

 1 0 0  x   −.43 

  

=  0 1 0  y  =  −2.69  … 7
 0 0 1  z   2.88 

  


3. The regression models
A linear regression is a set of n (the number of observations) linear equations, each with k variables. The
matrix format for linear regression imposes a standard “flat file” data structure, expressed as a
rectangular matrix, with n rows and k columns. The data matrix X appears in Excel, with the first column
enumerating the unit of analysis – dates for time series data and observation units (households, firms,
countries, survey respondent numbers…) for cross-sectional data. Pooled time series/cross-section data
follow the same rules with a slightly more complex file naming strategy.
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Cross- sectional file of families,
where first column, FAMNUM
enumerates the record for each
family in the data. The other
columns show the variables
defined in the data.

 657758

 648066
 661525
X =
 683842
 ...

 ...

11360
11409
11722
12192

27159
27559
27810
29130

...
...
...
...





X =





1
1
1
1
..
0

0
0
0
62
..
0

143
143
155
277
..
238

...
...
...
...
...
...





















Time -series file of four
Note that the variable labels are not
jurisdictions - CA, NF, MB, and BC
part of the data matrix, although most
families, where first column is
statistical programs, including Excel, will
Date (year), and the other
accommodate the inclusion of labels in
columns show the variables
the input. In time series data, time may
defined in the data.
be an independent variable but never
as a raw date; the researcher usually
creates a new time variable, where the
first value becomes 1 and subsequent values are numbered consecutively. In the example here, 1981 =
1, 1982 = 2, and so on. The important idea is that these are n x k (n by k) matrices, designated by X.
Recall the regression figure from Module 7 (Section 2.2). Each observation has a unique equation; for
example:
©Gregory Mason, July 2022
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The entire model has six equations

Y

y1 = ao + a1X11 + e1
y2 = a0 + a1X 21 + e2
y3 = a0 + a1X 31 + e3
y 4 = a0 + a1X 41 + e4
y 5 = a0 + a1X 51 + e5
y6 = a0 + a1X 61 + e6

e5
e6

e2
e3

e4

e1

The independent variable xij has two subscripts to
accommodate the multiple regression model.

X1
X11

…8

X21 X31 X41 X51 X61

Therefore, X31 is the third observation of variable x1.
In matrix form, the equations in 8 become:

 y1  
  
 y2  
 y3  
 =
 y4  
 y5  
  
 y6  
(6 x1)

x11 
 e1 

 
x21 
 e2 
x31   a0   e3 
  +  
x 41   a1   e4 
 e5 
x 51 

 
x 61 
 e6 
(6 x 2)
(2x1) (6x1)

1
1
1
1
1
1

…9

It is useful to check conformal rules (the brackets below each matrix). On the left-hand side, a 6x1 matrix
is equal to a 6x1 plus a 6x1 matrix. Equation 9 becomes compact when written as:

Y = XA+e ,
where Y is an n x 1 vector (matrix), X is an n x 2 matrix, and e is an n x 1 column vector. (Note: Any
matrix that has one of its dimensions =1 is often referred to as a “vector.”) A multiple regression with
these variables appears as

 y1  
  
 y2  
 y3  
 =
 y4  
 y5  
  
 y6  
(6 x1)
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1
1
1
1
1
1

x11
x21
x31
x 41
x 51
x61

x12
x22
x 31
x 42
x 52
x62

(6 x 4)

x31 
 e1 

 
x32   a0   e2 
 
x33   a1   e3 
+ 

x 43   a2   e4 
 
x 53   a3   e5 

 
x63 
 e6 
(4x1) (6x1)

…10
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Mathematical manipulation (available in any econometrics or statistical text on regression) provides the
estimate of ai.

 a1 
 
 a1 
a 
A =  2  = (X'X)-1 X'Y
:
:
 
 ak 

,

… 11

where X’ is the transpose of X, and X’X-1is the inverse of the X’X matrix, also known as the crossproduct matrix.
1 7


3 1
 1 3 −1 9 
If the matrix C = 
, then C ' = 
 , then
 −1 −2 
 7 1 −2 4 


8 4

 50

10
CC ' = 
 −15

 36

10
10
−5
28

3
35 

−5 31 
 83 48 
and C 'C = 

5 −18 
 44 68 

−16 88 

CC’ is a 4x2 matrix times a 2x4 matrix creating a 4x4 matrix, and C’C is a 2x4 matrix times a 4x2 matrix
creating a 2x2 matrix. In the single variable regression, a cross-product matrix appears as

 1
X'X = 
 x11

1
x21

1
x31

1
x41

1
x51




1 

x61 




1
x51

 y1 
 
n

 y2  
yi 


1   y3 
i =1

  = 
x61  y4   n

x i 1 yi 


 y5   i =1

 
 y6 

1
1
1
1
1
1

x11 

x21  
n
x31  
=
x 41   n
 x i1
x51   i =1

x61 

The next step is to calculate X’Y

 1
X 'Y = 
 x11

1
x21

1
x31
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1
x 41



i =1

n

x i21 

i =1

n

x

i1
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Example 12F: Given the following data, compute the regression coefficients for the linear
model:

See Example 12F.xlsx

y
23
12
15
5
24
45
17

x
6
3
4
1
6
9
4

4. Input-output analysis1
Economists have always sought to create abstract and simplified models as a way of capturing the
essence of economic processes. Viewing an economy as a set of inputs transformed into a set of outputs
captures a basic reality. Quesnay’s Tableau Economique (Economic Picture) represents an early attempt
to see the economy as a continuous and circular flow of inputs transforming into outputs. The modern
input-output table stems from the work of Wassily Leontief.
The concept starts with observations and assumptions, the most obvious being that any economy
comprises multiple sectors, each supplying some sectors and dependent on others for inputs. This
interrelationship and mutual dependency form the “structure” of the economy, expressed as a matrix
showing the flows among the sectors. This matrix expression supports the analysis of exogenous shocks
to the economy. Input-output (I-O) analysis often appears in economic impact analysis for large national
investment projects involving government support when planners wish to calculate an overall return to
public investment. Statements such that the economy will expand by $10 billion with a $500 million
investment often have an I-O analysis supporting part of the argument.
Consider the following
“economy” with three inputs
Y, Z, and R that support three
outputs Y, Z, and D,
respectively. This unique
economy has important
assumptions:

I-O Flows
Y
Inputs
Z
(Industry) R
Total

Y
420
84
336
840

Outputs
Z
150
200
150
500

D
270
216

$m
Total
840
500
486

486

1. The final demand for each community (row and column totals) are exogenous (determined by
actors outside the economy).
2. In this simple model, each industry has one product.
3. The technology features constant returns to scale; doubling the input doubles the output, etc.

1

This section draws from Rosser, M., and Lis, Piotrorter (2016) Basic Mathematics for Economists, London,
Routledge.
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4. This is a simple closed economy, and an industry may consume its own output (such as Z
supplying itself 200 units in the example).
5. No surplus or profit exist – the sum of each row equals each column.
This is a simple general equilibrium model. Of course, we can relax some assumptions – not the one
about constant returns to scale – and matrix algebra can support the use of this model to support
important policy analysis.
Imagine an economy with two industries, one resource and the other as inputs. Official statistics
agencies such as Statistics Canada typically manage the creation of input-output tables because the data
requires detailed survey information on what firms purchase from whom and sell to whom. Typically,
only central statistical agencies can gain the cooperation of enough firms to collect the needed data,
comprising sales or purchases per period in currency. The entries in the table are financial flows per
period, typically a year for national tables.
Referring to the example above, the total output of Industry Y is $840, $420 of which it consumes, while
Industry Z consumes $150 and $270 is purchased in final demand – D (general consumers). The final
demand category is important because changes in demand are what propels the model. The first column
shows Sector Y using $420 of its own output, $84 from Sector Z, and $336 units of resource R for a total
$840 in inputs.
This table of sales and consumption flow supports an
input/output coefficient table that forms the core of IO analysis. Each element of this matrix reflects the
ratio of input to output flows. The numbers in brackets
only show the calculation not included in the matrix.

I-O
Coefficient
Matrix
Y
Z
R

Y

Z

.5
.1
.4

.3
.4
.3

In the first upper left cell, .5 (420/840) is the proportion of total output from Industry Y that it uses in
satisfying its own production needs. To illustrate, the production of electricity requires electricity. One
unit of production of Y requires .5 units of its own product, .1 units of Industry Z’s output, and .4 units of
resource R. Note that the ratios of each column sum to one. This “technology” matrix (another name for
the I-O matrix) shows how the input sector’s outputs plus resources flow among the input sector.
The last column D (final demand) determines the input flows. To illustrate, with the I-O matrix above
and assuming 600 units of R is available, is it feasible for final demand to be 324 of A and 261 of B? To
answer this, use the I-O matrix to write two demand equations for industries A and B:

Y = .5Y + .30 Z + 324
Z = .1Y + .4 Z + 261

... 12
... 13

So,

.5Y = .3Z + 324 (multiply by 2)
Y = .6 Z + 648
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Substitute 16 into 14 to obtain Z B = 603.3 . Now substituting this into 14 gives Y = 1,010. Now, using the
last row of the I-O matrix:

R = .4Y + .3Z = .4(1010) + .3(603.3) = 404 + 181 = 585

... 16

This is below the 600 units of R hypothesized, so this production is feasible. Let us set this up in matrices
and show how to explore variations in the technology matrix to solve production problems.
Translating the current problem into a matrix formulation is straightforward.

Y = .5Y + .3Z + 324
Z = .1Y + .4 Z + 261
(1 − .5)Y − .3Z = 324
−.1Y + (1 − .4)Z = 261
Let

 0.5 0.3 
 324 
A=
 , and the final demand vector is d = 
 , which creates the simultaneous
 .1 .4 
 261 

system

See: Example 12G.xlsx

 1 0    0.5 0.3   Y  324 

  − 
   = 

 0 1    0.1 0.4    Z  261
= (I − A)x = d
x = (I − A)−1 d

... 17

Now our problem requires a solution using matrices. The first step is to compute (I − A)−1 multiplied by
d to produce the required values of Y and Z.

Example 12H: A central statistical agency
X
Y
D
Total
Output
collects the following information on sales
X
1095
495
600
2190
and purchases in a small economy with two
sectors X and Y, plus resources R. Remember
Y
438
660
552
1650
an I-O model represents a closed economy,
R
657
495
0
1152
so everything produced is consumed. In this
Total Demand 2190
1650
1152
example, total demand = total output = 1152.
In this example, total final demand D = total resource consumption R. Sector X sends some of its
output to itself (1095), some to Sector Y (495), and some to final demand (consumers) at 600.
Sector Y sends some of its output to Sector X (438), some to itself (660), and some to final
demand (552). Resources used to meet the demand of Sector X and Sector Y are 657 and 495
respectively. You can see that adding up (the more heavily shaded cells) shows that total output =
total input = 1152.
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Economics Analytics: ECON 2050

Module 12: Matrices and Array Formulas – Applications in economics
The next step is to calculate the I-O coefficient table.
Calculate the I-O coefficient table (the A matrix) and estimate what happens if the demand for X
increases to 690. Constructing the I-O matrix creates the relevant equations:
0.5
0.2
0.3

0.3
0.4
0.3

X = .5X + .3Y + 690
Y = .2X + .4Y + 552
=
(1 − .5)X − .3Y = 690
.2x + (1 − .4)Y = 552
=

1095/2190 = .5
and so on.

It is a coincidence that the
A matrix is the same as the
first two rows of the I-O
matrix.

 1 0    .5 .3    X  690 

  − 
   = 

 0 1    .2 .4    Y  552
Example 12I. I-O problems are scalable, which is fortunate since actual I-O tables may have a
hundred sectors and many types of resources.
Agricultural
Manufacturing
Services
Resources
Total Demand

Agricultural Manufacturing Services
Demand Total Inputs
996
495
325
700
2516
438
490
300
585
1813
657
495
570
305
2027
425
333
832
2516
1813
2027
6356
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996/2516 = .4 and
so on.

The I-O matrix appears as
0.40
0.17
0.26
0.17

0.27
0.27
0.27
0.18

0.16
0.15
0.28
0.41

A = .40 A + .27M + .16 S + 700
M = .17 A + .27M + .15S + 585
S = .26 A + .27M + .28 S + 305
=
(1 − .40)A − .27M − .16 = 700
.17 A + (1 − .27)M − .15S = 585
.26 A − .27M + (1 − .28)S = 305
=
 1 0 0    .40 .27 .16    A    700  

  
     

 0 1 0   −  .17 .27 .15    M   =  585  
 0 0 1    .26 .27 .28    S    305  
See: Example 12H.xlsx

An I-O table represents a closed economy (no trade) with constant returns to scale. A common use for
an I-O model is to simulate the impact of an endogenous expansion of final demand in one sector on the
final demands for other sectors. Often proponents of large capital projects in one area of the country
will argue that, because the project will use inputs from all parts of the country, the benefits are not
local and will permeate the entire economy. Example 12I shows how to simulate the impact a change in
final demand for one sector has on all sectors.
It is important to accept the limitations of I-O models. The assumption of constant returns to scale
implies that, as industries expand, unit costs remain the same. Technical change does not enter in an I-O
model without completely redoing the data collection and creating an entirely new model. The inputs
for a project, such as a wind farm, must link to industries in the I-O table. If the table is older, it is
possible it will not reflect current technology. No inflationary pressures exist, and analysis occurs at a
point in time. The costs of financing new projects do not appear in the model.
Yet this model offers a way of understanding the impact of increases in demand in one sector on the
entire economy. It allows one to assess the claim that a wind farm in BC will benefit industries in other
©Gregory Mason, July 2022

Economics Analytics: ECON 2050

Module 12: Matrices and Array Formulas – Applications in economics
provinces. Of course, if the inputs for constructing a wind farm come from offshore, the I-O analysis will
show only benefits for the rest of the industry.
On a final note, I-O will technically fail if it is not possible to create an inverse to the matrix (I-A). If a row
(or column) is a linear function of other rows (columns) an inverse will not exist. If you develop an I-O
model and the inverse function fails, fixes exist, but these are beyond the scope of this text.

5. Tables and dynamic arrays
These two topics do not deal with economic computations, but economists will need to access and
manipulate information to create reports. Also, dynamic arrays update reports whenever source data
change.
In 2018, Microsoft introduced the idea of a dynamic array. This, along with a new tables format, reduces
the work needed to update reports as new data arrive and reduces the trickiness and tedium of
developing array formulas. Dynamic arrays are only available in MS 365 and Excel 2021, but it is still wise
to know the “old fashioned” way of doing things since many workplaces have legacy versions.
5.1. Tables
One of the quickest ways to increase processing speed
in summarizing data is to place it in a table. The data
used for regression in Module 6 were in rectangular
arrays, with variable names as headers. Using the Sort
functions in Excel under the Data tab will accomplish
basic reorganizations of the information (arranging in
ascending or descending order). Defining an array as a
Table in Excel opens possibilities for quick
reorganization.
Selecting Insert → Table will produce the following
menu, but it is much easier to view the video than read
about the actions.

Video: Inserting and Naming
Tables
See: Example 12III.xlsx
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On the left is the data array with headers, while on the right is the same information inserted as an Excel
Table. Again, the video illustrates the potential of this operation. Note the addition of drop-down menus
on each header in an Excel Table.

5.2. Sorting
MS 365 and Excel 2021 offer two powerful sorting operations, SORT and SORTBY, that use dynamic
arrays. The advantage of these tools is that, when combined with naming an array, both functions
update as the latest information enters the table (e.g., a change in a value or the addition of new data).
See: Example Names, SORT,
and SORTBY.xlsx

Video: SORT and SORTBY

5.3. Frequency function
The final array function supports the creation of histograms without using the dialogue box under Data
Analysis. This becomes useful in creating policy models where you need to analyse how changing
assumptions affect model results. The video and spreadsheet also illustrate how to generate numbers
for quick analysis and name ranges and vectors.

See: Example Frequency
Function.xlsx
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6. Summary
This Module introduces Excel as a process for calculating higher order economic analytics using vectors
and arrays. It also introduces array formulas and dynamic arrays. By design, it does not cover Pivot
Tables, which offer powerful summarizing techniques without tedious formula writing. Every economist
should have familiarity with Pivot Tables, but these are data management procedures and strictly do not
involve economic analytics.

Annex: Key Excel formulas and functions
This Module introduced new functions, notably array formulas that make intelligent guesses about
actions. Transforming Excel arrays into tables (assuming each column has a header [title]) and then
naming the table offers important “resilience” since updates to the table (changing a value or adding
information in the form of new rows or columns) will update all your calculations without the need for
changing formulas in detail.

Function
=XLOOKUP(lookup-value,
lookup-array, return-array,[
if_not_found], [match_
mode], [search_mode])

Example
=XLOOKUP(B4,A7:A17,C7:C13,,-1)

=MMULT (array1, array2)

=MMULT(A1:C10:F3:O3)

=SUMPRODUCT(array1,array2, =SUMPRODUCT(A1:A10,B1:B10)
array3…)

=MINVERSE(array1)
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=MINVERSE(C2:E4)

Explanation
This function searches two
columns for the value in B4.
The next two arguments are
not used (for this example),
and the search mode is for an
exact match or the next
smaller value.
This function multiplies two
conformal matrices. Verify
that the example has
conformal matrices.
Multiply the vector A1:A10 by
the vector A1:B10. Study the
examples in the help area (F1)
to see how powerful this
formula can become.
Take the inverse of matrix
(array). This assumes a
determinant exists and that
array1 is square.
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Function
=MDETERM(array1)

Example
=MDETER(F4:I7)

=TRANSPOSE(array1)

=TRANSPOSE(A1:U300)

=FREQUENCY(data array, bin
array)

=FREQUENCY(A1:A3003,J1:J10)

Explanation
This function computes the
determinant of a square
matrix. If rows or columns are
linearly dependent, the
determinant does not exist
and a “VALUE!” error results.
This takes the transpose of an
array, which need not be
square.
Developing a frequency
distribution and histogram
becomes easy with this
function. This function is
useful in probabilistic models.

Note: 1) Array is always specific to the function; 2) Naming arrays will clarify your code; and 3)
Making arrays into Excel tables, labelling columns (or rows) can increase flexibility and leads to using
Pivot tables for reporting.
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